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Business monthly budget template google sheets

If you keep creating the same spreadsheet in Google Sheets, you can save a lot of time creating a template. We will guide you through the process step by step. Google Sheets has a wide range of templates to choose from, but it's possible that none of these templates meet your specific needs. If you
want to create a custom template that you can use as needed, there is a workaround that you can start with. First, fire up your browser and go to Google Sheets. Open an empty spreadsheet, a table that you created earlier, or one of the Google templates. Now that you have some bones for your table
template, click the file name at the top of the sheet and rename it to something that contains the word template. Press Enter when you're done to save the changes. Next, click the folder icon next to the file name, and then select the New Folder icon to create a new folder for your Google Table templates.
Enter a name for the new folder and click the check mark to create it. Click Move Here to save the template to your new Google Table template folder. This folder can now be the new home for all future templates you create. This is also a great way to find everything in your Google Drive neatly organized
and easy for anyone who is part of your team. RELATED: How to organize your Google Drive If you need to make a copy of your templates, go to Google Drive, find the folder you just created for your templates, and double-click it. Because it is a template file that you want to use multiple times, you
should make a copy of it before you start editing or adding information. To do this, right-click the template and select Create Copy to duplicate the file. The copy of your template is stored in the current folder with the prefix Copy of. From here, you can double-click the file to open it, rename it, or move it to
another folder. If you open the document or someone sends you a template file, click File &gt; Copy to copy the template to your drive. Name the file, select a location for it in your drive, and then click OK to save it. That's all there is! If you want to share your template with other team members, you can
create a Copy link and send it to them in an email or share it with a shared link. RELATED: How to share Make a Copy links to your Google files. If you Pay for your G Suite account, you can save custom templates to your custom template gallery so that all your team members can use them. If you're
using the free version of G Suite, you can use the method described above. Free accounts can share custom templates without additional spending. Customer Relationship Management (CRM) software helps sales teams track leads, contacts, and opportunities. While dedicated CRM software includes
additional features, you can easily set up a Google Sheets CRM to track the most important information when you Start. We'll show you how to do it in just seven simple steps. If you want to track more than just records in Google Sheets, Salesforce Essentials is a CRM with an easy-to-use interface, an
intuitive mobile app, and a 360 view of every deal and contact. This small business-optimized CRM costs USD 25 per user per month, and you can try it for free for 14 days. Salesforce Free CRM Spreadsheet Template Setting up the Google Sheets CRM template to track leads, contacts, and
opportunities doesn't have to be complicated or scary. In addition to the steps to set up your own below, we have a free template that you can use to start managing contacts and offers. We created this template in Google Sheets, but you can easily follow the same steps to create one with similar features
in Excel. Download the free CRM spreadsheet template To set up your CRM in a spreadsheet, follow these seven steps: 1. Define your sales process before you start creating a CRM using a spreadsheet to define your sales process, including tracking, and decide what information about your quotes and
contacts to include. It saves you time and effort later if you have already defined your process and planned how your contacts will move through your sales pipeline. Some aspects of the process should be considered: Decide how contacts should be tracked Create a sheet to track contacts that can be
either leads or customers. Some CRM software provides the ability to track each of these items separately, which can help you sort them out, who is a customer, who is a partner, and who is still in the lead process. For our Google Sheets CRM template, it's easier to simply use a column to specify the
type of contact than copy and paste. Consider how deals move through your process deals are the opportunities you want to close. We recommend that you create a separate sheet in your table workbook to track the progress of deals. Consider how you move stores through your sales process and how
you identify the different phases. A Google table table is useful for tracking the progress of a deal, but there are also several simple CRM systems that can save you the time and aggravation of setting up a system yourself. If you specify your pipeline process phases for leads and deals, consider the
phases in your sales process that you want to track in your CRM. These are the Steps in their pipeline that help move a lead from the initial discovery by completing a deal. For example.B you can use the following phases for your leads and quotes: Incoming Request: This is the phase in which you first
receive a request from a potential customer. They may have filled out a form on a website or sent you an email. They don't know yet if they fit well, but they've shown interest. Qualified Lead: Use this phase to that they are best suited to your target customer and are most likely to become customers. You
have additional information, either from direct contact or because the customer has been replaced by your marketing funnel. Advice: This represents the point at which you have a sales-oriented needs analysis to determine the specific needs of your lead and whether you can meet them with your product
or service offering. Suggestion: This is the stage in which you created a sales proposal and submitted it to your potential customer based on the needs-based assessment you have performed. Contract: Use this phase to indicate when your contacts accepted your proposal and you negotiate and prepare
a contract for the company. Won or lost: This is usually the last phase of a sales process and indicates whether a lead customer has become a customer or not. Identify potential lead sources You should also use your spreadsheet to track where your leads come from so you can make informed decisions
about where you want to invest your future marketing efforts. Specifying whether a lead or opportunity comes from a personal recommendation, online advertising, or a lead generation campaign can help you track and monitor your marketing efforts and assess which efforts are most effective in
generating new businesses. 2. Choose your spreadsheet software An important factor to consider is which spreadsheet software to use. It may not seem like a big deal, but the table you choose is really important, especially if you need sharing features or advanced formatting. Two of the most popular
spreadsheets and Microsoft Excel are, but there are also Apple's numbers for Mac users. You can read our article about G Suite vs Office 365 for more information on how the two compare. For this guide, we use Google Sheets to represent each of the steps, as it can be used free of charge by anyone
with a Gmail address. When you use Excel, the steps are the same, and you can easily customize them to accommodate minor Excel differences in the nomenclature. If you are an Excel user, you can also simply click the template link above and download it as an Excel file. Download the Google Sheets
template or Microsoft Excel Google Sheets Google Sheets is part of the G Suite collection of browser-based productivity software and is available for personal use to anyone with a Gmail account. One of the strongest features of Sheets is real-time collaboration and sharing functionality that allows
multiple users to document the same document at the same time and edit it. This is ideal for teams that want to create a central CRM from a shared spreadsheet that is easily accessible to all users on all their devices. Microsoft Excel Excel is by far the most widely used spreadsheet software by
companies for everything from accounting reports to human resources management (HR). It is available as a desktop application for Windows and Mac computers Mac computers as on mobile devices. It is also available as a browser-based app called Microsoft Excel Online. With Excel to create your
spreadsheet, you can take advantage of some of the advanced features, such as data visualization tools and 2D map charts. Numbers Another option for Mac users to consider is Numbers from Apple. Numbers is available as a desktop, iPad, iPhone, and browser-based software, and includes real-time
cloud-based sharing capabilities via iCloud. This allows users to keep their spreadsheets in sync with device and shared users. Numbers is easy to use and has many of the same advanced calculations as Excel, but it's only available for MacOS and iOS. 3. Create your spreadsheet The next task is to set
up your spreadsheet and configure it for use as a CRM. We'll go through the steps that you can take to add contact information in a minute, but before we do, there are a few household goods items that make it easier to use your spreadsheet. Decide where to access data. One of the first decisions you
need to make is whether you're working primarily with your file on your desktop or whether you want to access it anywhere, such.B as a remote location or your smartphone. The best choice depends largely on whether you share your CRM with other team members or work on it alone. Excel is offered
through an Office 365 subscription as a standalone desktop application as well as a mobile and browser-based app. Google Sheets, on the other hand, is only available through the cloud. If you share access with others, you'll find that the online version of Excel or Google Sheets is the better choice.
Create your tables Most spreadsheet software applications allow you to create multiple workbook sheets (not to be confused with Google Sheets, the program) in one file. This is especially useful when creating a CRM in a spreadsheet because you can use different sheets to track contacts and deals. We
recommend that you set up two sheets in your workbook to track your contacts and offers separately. Use multiple sheets to keep data separate Sheet Number 1: Contacts Your contacts are the people you interact with and communicate with. These can be new leads, existing customers, partners, or
even sources of recommendation. You use this sheet to track their information and take notes about your interactions and conversations. Sheet Number 2: Deals Your Deals sheet is used to track opportunities that represent specific transactions that you and who move through your sales process. Some
industries, such as Cloud-based Software as a Service (SaaS), may not necessarily pursue deals, but move through a lead maintenance process to close the sale when they sign up. However, many industries either sell products or services (or both) and need a way to track their sales process. Specify
sharing settings Whether you are just working on this CRM or using it with a team, you should set sharing settings. One of the benefits of Google Spread and Microsoft Excel Online is that multiple team members can work on the same file in real time, making collaboration easy and intuitive. This ensures
that all your contact information is up-to-date so that your sales people get the most up-to-date information you can work with. In Google Sheets, sharing is as easy as clicking the blue Share button at the top right of the user interface. You can either grant file access to specific people, or if you are a G
Suite customer, you can allow everyone in your organization to interact with the file, provided they share the same domain in their email and user profile. Specify sharing settings To set security and user permissions Because you store your contacts' personal and business information, security is an
important aspect. Both G Suite and Office 365 use 128-bit automatic encryption to securely store customer data and HTTPS for transferring data to and from the server. Both are also HIPAA-compatible when using browser-based or mobile app versions. You can also use the sharing features of both to
restrict access to specific people. 4. Name your column headings Now that you have set up your spreadsheet file, you must create headers for each column. You use columns for the different types of information that you want to track for each contact and deal. The rows in your spreadsheet contain
individual records. One of the reasons to think about the headers you're going to use is that each represents a data point that you can use later to sort, search, and find specific records. Contact sheet headers We recommend that you use the following headers for your contact sheet, but you can change
them to add more types of information that you need to track. Use this list to ensure that you collect the information you need to connect to your leads and customers and move them through your sales process. The headers we used in our template are as follows: Contact: Each deal should be assigned to
a person, regardless of whether it is a lead or an existing customer. Email: This should be the email for the primary contact. Phone: This should be the main or primary phone number for the contact. Company: Use this field for the company or account to which the deal is associated. Title: It is Helpful to
know where your contact fits into your entire organization, especially if you need to know if they are likely to be a decision maker or not. Address: Here you can keep the postal address of your contact. Contact type: Because you can use this sheet to track different types of people you are communicating
with, you should be sure whether it is a lead, customer, or other contact type. Stage: Depending on how you purchase new leads, you can use them to track where a contact is in your lead care process. Source: If you know where your new customers are coming from, you can make better sales and



marketing decisions. Last contact: You should track the last time you communicated with a contact. Use this field to update the date each time you send an email or talk to a contact. Note: Take notes here about conversations or other communications you have with the contact, as well as the required
action steps. This ensures that you always have up-to-date information the next time you or someone else on your team communicates with them. Owner: Use this field to specify who is responsible for this deal. Name your contact sheet headings Deal Sheet Headers similar to the contact headers above,
we recommend using the following headers for your deal sheet. You can still add additional headers based on the information you need to move stores through your sales process, but they should ensure that you collect and track the most important information. We used this in the above template: Deal
Name: This is what you will call the deal (e.B. website for Bob's cleaning service). Use names that you can quickly find and assign to specific opportunities. Deal Description: In addition to the name, it may be helpful to include a brief description of the deal so that you and your team can reference the
scope of the opportunity. Deal Value: This represents the estimated or suggested value of the deal. Depending on the type of products or services you sell, this may be the one-time cost, or it may represent the value of a contract that is distributed over time. Deal category: If you sell multiple types of
products or services, you can use this to easily identify the type of opportunity. In the example I mentioned, the category could be website design. Deal Stage: You can use this field to easily specify and identify where each opportunity is in the sales process using the previously defined phases. Contact:
Each deal should be assigned to a person, whether it's a lead or an existing customer. Email: This should be the email for the primary contact. Phone: This should be the phone number for the primary contact. Company: Use this field for the company or account to which the deal is associated. Source: If
you know where your new customers are coming from, you can make better sales and marketing decisions. Probability of closing: If you get an idea of it Which deals are most likely to be completed, use this field to track the percentage probability that each opportunity will be closed. This allows you to
calculate the current value of each deal. Last contact: If you're interacting with a contact for a deal, update this field so you can see later which offers you need attention, depending on how long since you have been in contact. Note: If you're talking to a contact about a deal, take notes about the
conversation, progress, and all the action you need. This ensures that you always have up-to-date information the next time you or someone else on your team communicates with them. Owner: Use this field to specify who is responsible for this deal. Name your Dealsheet headers 5. Import your existing
data regardless of what you've used to track your contacts, you want to move all of this contact information to your new spreadsheet so you can start completing more quotes and converting more leads to customers. There are several ways to do this, depending on where your contact information is
currently stored. Here are some of the most common ways to import your information: Manually entering data Depending on how many contacts you have, one of the easiest ways to populate your new CRM spreadsheet is to manually enter your contact information in your spreadsheet. You simply enter a
contact record or deal for each row in the spreadsheet. If you have only a few contacts so far, this is a manageable way to integrate your information into CRM with minimal effort. Import From Email Probably you've tracked all your contact communications with your email so far. This works well if you only
have a small number of contacts or deals, but can become overwhelming as that number grows, which is probably why you're looking for a better solution. Many CRMs provide direct integrations with Outlook or Gmail, but for this guide, we want to talk about how you can get this information from your
inbox into your brand new spreadsheet. If you're using Gmail, you can easily export your contacts to a CSV file, open that file in Excel or Google Sheets, and then copy the records to your new spreadsheet. For many users, this may be the easiest option, but if you have a large number of contacts, the
good news is that there are ways to make the process more automated. For example, you can use Mailparser to export e-mail and translate it into your spreadsheet. It's a paid service, but they have a 14-day free trial during which you can export a batch of files and send them to your new spreadsheet.
Import from other software If you previously used some kind of contact management tool such as an address book or your outlook contact list, you can typically export your contacts as a CSV file that is available in Excel or Google Sheets can be used. This also applies if you use tools such as Mailchimp
or Constant Contact and want to move your contacts to a CRM table. Pro tip: If you're currently using one of these tools, it's sometimes easier to do this first and export your contacts to a CSV. Then open this file in Google Sheets or Excel and change the resulting spreadsheet according to the format
described above. In this way, you have already entered the contact information in your and you can then add and move columns as needed. 6. Create Automations &amp; Integrations One of the powerful benefits of spreadsheet software is that you can use them not only to store information, but also to
interact with your data. This transforms your CRM from a list of names into a tool that helps you keep your sales process up to date and win more new business. Here are some ways you can set up your CRM table to work for you: Conditional formatting allows you to create rules based on the information
in a cell. For example.B you can set up a rule that would make the cell background red if the date in the Last Contact column was more than four weeks ago, and you can indicate that you must contact this lead. In fact, we set up the sample template to do just that. Add conditional formatting to your sheets
If you want to know how to do this yourself, follow these simple steps: 1. Select the cell, row, or column you want to format. For your CRM, you should most likely select a column because all the information in each column is a specific type of information. 2. Right-click your selection, or click on the Format
menu and select Conditional Formatting. 3. You will then receive a list of rules that will be applied to your selection, as well as the Add New Rule option. 4. Next, you should see your selection in the Apply to Range box. If not, simply add the range of cells to which you want to add formatting. 5. In the
Format Cells if... field, select the condition that must be met for the formatting to be applied. This can be related to a date or other value. You can even add a condition for a field that is empty or contains a specific type of text. 6. Finally, select the formatting to apply if the condition you apply is met. You
can change the color, font, or style in a cell. Using data validation lists Another useful way of automating is adding data validations, which means that only certain data types can be added to a cell or range. In the sample template, we used this function in the Contact Type and Stage columns to limit the
information to specific lists. The setup process is similar to adding conditional formatting and helps you keep your CRM data clean and organized, making it easier to sort and edit your contact information. Data validation in Google To add data validation in Google Sheets, simply do the following: 1. Select
the cell, row, or column to which you want to add data validation. Again, you should most likely select a column because all the information in each column is a specific type of information. 2. Right-click on your selection or click on the Data menu and select Data Validation. 3. The selected selection should
be specified in the Cell Range field. If not, you can add it manually. 4. Select the type of validation you want to use. We have selected a list of items. 5. Enter the list for which you want to Drop-down menu, where each term is separated by a comma. 6. To ensure that only your list of terms can be used,
select Reject entry in the Invalid Data box. 7. Save your changes. Integrate with other tools After you set up your CRM, you can use third-party automation tools to keep your CRM data up-to-date when generating new leads. For example, if you use a lead generation tool such as Mailchimp, Zapier sends
new subscribers who fill out your subscription form on your site directly to your spreadsheet as new rows. Zapier actually makes this easy, so you can assign fields directly from the form to the appropriate fields in your CRM table. Mailchimp to Google Sheets Integration with Zapier 7. Generate reports
With a spreadsheet for a CRM, you can keep your information organized and create basic reports with the features mentioned above as well as other features in Google Sheets and Excel. Now we're talking about some ways you can use your data to simplify the sales process by giving you reports and
insights into your contacts. Sort by columns Your CRM data can be sorted by columns so you can organize the data by any characteristic or type of contact information. You can e.B. Keep your degrees and contacts in alphabetical order, in order of dementor value, or in the order of the last contacts. To
sort data, move the cursor over the top row and click the selection arrow that appears. Scroll down the menu and choose whether to sort the column in ascending or descending order. Using filter views in Google Sheets Create Filters Filtering is a powerful tool that allows you to create individual views
based on specific conditions or values. As an example, you can create a view that shows you the leads that you didn't communicate with in the last month, or a view that shows you all deals over 5,000 dollars that are likely to close at least 80%. You can use filtered views to generate reports that give you
insights into your contacts that you can respond to. Set up filters by selecting the Data &gt; Filter Views &gt; Create a new filter view menu. You can then select the columns you want to filter and how you want to view your data. Filtering removes all records from the view that do not meet the conditions
you specify. FAQ Which spreadsheet tool should I use? The specific which is best for your business depends on several factors. When real-time sharing and collaboration are the most important, Google Sheets is the best choice. When PC compatibility and advanced productivity are most important,
Microsoft Excel is the best choice. When should I switch to a CRM? The decision to take the plunge and sign up for a fully functional CRM depends on many factors. However, if you manage more than 50 contacts or more than five deals at a time, it probably makes sense to CRM-specific software. If you
have a tight budget, multiple CRMs offer free plans forever. What is the difference between spreadsheet and database software? A spreadsheet is a collection of records organized into rows and columns of cells that can be sorted and filtered. In addition, table calculations and other formatting can be
applied to either a single cell or a range of cells. Database software also manages a collection of information, but the main difference is that it is relational, which means you can connect different data types to establish a relationship between them. For example, you can have a contact in your database
and associate that record with an opportunity or an account. The database tracks the relationship and keeps the data connected behind the scenes. Tables allow some way to join cells and sheets, but their ability to establish relationships between different record types is limited. Conclusion: Google
Tables as CRM For companies that want to take control of their contacts and close more stores, creating a CRM in a spreadsheet can help optimize their sales communication efforts. While spreadsheet software such as Google Sheets does not have the advanced features in dedicated CRM software for
small businesses, this can be a cost-effective, no-frills way to move away from your inbox to a more productive sales process. For companies ready to make the leap to dedicated CRM software, we recommend Salesforce Essentials because it provides contact and deal management, email tracking, and
customer support capabilities for as little as USD 25 per user per month. Visit their website today to start your 14-day trial. Visit Salesforce Salesforce
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